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About this guide 

This document describes the steps necessary to integrate automatic credit card processing using 
Payflow Pro and ICVERIFY, third-party credit card processing software packages and services, with 
Infor Distribution FACTS. 

Intended audience 
This guide is for FACTS end users, managers, in-house analysts, and trainers who require an 
understanding of the automatic credit card processing and how to use it. 

Related documents 
You can find the documents in the product documentation section of the Infor Xtreme Support portal, 
as described in "For information about other Infor Distribution FACTS modules or basic usage 
information, see the users guides in the Infor Distribution FACTS PDF Library.  Access these guides 
from the bookmarks of this document: FACTSDocNavigation.pdf. 

Contacting Infor" on page 5. 

For information about other Infor Distribution FACTS modules or basic usage information, see the 
users guides in the Infor Distribution FACTS PDF Library.  Access these guides from the bookmarks 
of this document: FACTSDocNavigation.pdf. 

Contacting Infor 
If you have questions about Infor products, go to the Infor Xtreme Support portal at 
www.infor.com/inforxtreme. 

If we update this document after the product release, we will post the new version on this Web site. 
We recommend that you check this Web site periodically for updated documentation.  

If you have comments about Infor documentation, contact documentation@infor.com. 
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About this guide 
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1 Chapter 1 Credit Card Handling 

 

 

Overview  
FACTS offers two methods for processing credit card transactions: manual and automatic.  Manual 
credit card processing can be done via voice authorization. Automatic credit card processing is 
possible by integrating the FACTS system with PayPal’s Payflow Pro software or ICVERIFY and 
using optional magnetic stripe devices, which are purchased separately. (Visit www.paypal.com or 
www.icverify.com more information.) 

With either method, FACTS users can perform sales, credits and voids. 

Credit Card Processing with Payflow Pro or ICVERIFY 
Payflow Pro and ICVERIFY are third-party credit card processing software packages and services 
that can be integrated with FACTS to provide automatic credit card processing capabilities.  

Those companies also offer or support several types of magnetic card stripe readers.  No device 
drivers or link files are required for most of these devices, as they are primarily “keyboard wedge” 
devices. Credit card processing companies often offer higher discounts to companies using card 
swipe devices. 

Credit Card Processing with Payflow Pro  
The interface between FACTS and PayPal’s Payflow Pro service employs Infor’s TCP/IP Manager 
for Electronic Payments product.  The TCP/IP Manager must be installed on a Windows machine 
that is available via TCP/IP to the server FACTS is installed on. 

FACTS communicates with the TCP/IP Manager via the TCP/IP Protocol, and the TCP/IP Manager 
in turn communicates with the Payflow Pro web service. 

All of the Payflow Pro settings are stored in FACTS and are sent electronically to the TCP/IP 
Manager. 

When processing with Payflow Pro, FACTS uses the Credit Card Processing program (SOC610) 
to gather all information, based on selections made in Credit Card Control F/M (SOF957). 
When PayPal updates their web interface, Infor evaluates whether a change is needed to the 
TCP/IP Manager and releases new versions accordingly. 
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Credit Card Handling 

Credit Card Processing with ICVERIFY 
ICVERIFY is a software product that gets installed on a machine that is accessible from the FACTS 
server.  Communication between FACTS and ICVERIFY is accomplished by flat file exchanges 
made in a directory both system are able to access. 

Support for ICVERIFY is limited to specific versions of ICVERIFY, so be very careful to determine 
what version is supported for your FACTS release, and only install that version of ICVERIFY. 

 
 

8 | Infor Distribution FACTS Electronic Payments Guide 



  

2 Chapter 2 TCP/IP Manager for Electronic  
Payments 

 

 

This section provides an overview of the TCP/IP Manager for Electronic Payments and all of the 
information that you need to install, start, and configure your application. 

NOTE:  The TCP/IP Manager for Electronic Payments is required only if you are using Payflow 
Pro with FACTS.  

You can download the TCP/IP Manager from Infor's Download Center located at 
www.inforxtreme.com. 

The TCP/IP Manager includes the installation of PayPal's software, so there is no need to install it 
separately. 

 

Installing the TCP/IP Manager for Electronic Payments 
In this section, you will install the TCP/IP Manager - Electronic Payment on the same PC where you 
installed Payflow Pro. The installation program allows you to select the destination disk drive and 
directory for the installation and copies the TCP/IP files to the destination disk drive. 

Before you begin the installation: 

• Disable any anti-virus software products. 
• Exit all Windows programs. 
• Disable all screen savers. 
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TCP/IP Manager for Electronic Payments 

To install the application: 

1 Insert the TCP/IP Manager installation CD-ROM into the CD-ROM drive of the PC where you 
installed Payflow Pro. After a few seconds, the setup application will run automatically. If your 
system does not support AutoPlay on the CD-ROM drive, select the Run command from the Start 
menu, enter D:\setup.exe (where D is the letter of your CD-ROM drive) and click OK. A progress 
bar displays while the InstallShield Wizard is being prepared. 

 
 

2 Click Next. The Customer Information Window appears. Enter your user name and company 
information. 
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TCP/IP Manager for Electronic Payments 

3 Click Next. The Choose Destination Location window appears. By default, the TCP/IP Manager 
will be installed in C:\Program Files\Infor Global Solutions\TCPIP Manager - Electronic Payments\. 
If you do not want the TCP/IP Manager to be installed in this directory, click the Browse button 
and select a new location. 

 
 

4 Click Next. The Start Copying Files Window appears. Review the installation settings. Click Back 
to make any changes. 
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TCP/IP Manager for Electronic Payments 

5 Click Next.  

 
 
 

6 When the installation is complete, the Install Shield Wizard Complete Window appears. 

 

 
7 Click Finish. You have completed the installation of the TCP/IP Manager - Electronic Payments 

application. 
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TCP/IP Manager for Electronic Payments 

Upgrading the TCP/IP Manager to the latest version 

If you have a previous version of the TCP/IP Manager installed, follow these instructions to upgrade 
your version of the TCP/IP Manager to version 1.3.0. 

1 Shut down the TCP/IP Manager on the desktop if it is running. 

2 If you have set TCP/IP Manager to run as a service, you must stop the service and uninstall it. 
To remove a previous version of the TCP/IP Manager that used the srvany method, go to a 
command prompt and type: instsrv MyService remove 

3 Insert the TCP/IP Manager installation CD-ROM into the CD-ROM drive of the PC which has the 
previous version of the TCP/IP Manager installed. After a few seconds, the setup application will 
run automatically. If your system does not support AutoPlay on the CD-ROM drive, select the 
Run command from the Start menu, enter D:\setup.exe (where D is the letter of your CD-ROM 
drive) and click OK.  
 
The following prompt appears 

 
4 Click Yes to perform the upgrade.  The Resuming the InstallShield Wizard for TCPIP Manager – 

Electronic Payments window will appear. 

 
5 Click Next.  A progress bar displays while the software is being updated. 

6 The Update Complete Window appears.  Click Finish. 
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TCP/IP Manager for Electronic Payments 

7 The upgrade of the TCP/IP Manager to the latest version is complete.  Restart the TCP/IP 
Manager. 

Starting the TCP/IP Manager - Electronic Payments 
1 Double-click the Launch TCP/IP Manager - Electronic Payments icon.  

 
2 The TCP/IP Manager - Electronic Payments Window appears. 

 
3 You have connected to the TCP/IP Manager for Electronic Payments. Electronic Payment 

transactions from FACTS will be processed as long as the TCP/IP Manager is running. 

4 From this window you can 

• Select Exit from the File menu to close the TCP/IP Manager - Electronic Payments. 
• Select Configure from the Tools menu to activate debugging or set the proxy server settings. 

Configuration of the TCP/IP Manager for Electronic Payments is necessary if you are using a 
proxy server. If you are using a proxy server, refer to Setting the Proxy Server Settings. If 
you need to troubleshoot processing, refer to Using the Debugging Feature. 

• Select About from the Help menu to display information about your release level.  
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Setting the Proxy Server Settings 

Configuration of the TCP/IP Manager for Electronic Payments is necessary if you are using a proxy 
server for your Internet connection. If you are not using a proxy server, leave these settings blank. 

1 Select Configure from the Tools menu. The TCP/IP Manager - Electronic Payments Settings 
Window appears. 

 
2 Set the following: 

TCP/IP Manager - Electronic Payments Settings Window Fields and Buttons 

Field/Button Description 

Debug Select this check box if you want the TCP/IP 
Manager for Electronic Payments to run in debug 
mode. Refer to Error! Reference source not found. 
for more information. 

Proxy Address Enter the IP address of the proxy server. 

Proxy Port Enter the port number used to access the proxy 
server. 

Proxy Log On Enter the user ID for logging on to the proxy server. 

Proxy Password Enter the password for the user ID. 
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TCP/IP Manager for Electronic Payments 

3 Click OK to save your settings. 

Using the Debugging Feature 
You can activate the debugging feature to help you troubleshoot if you are having communication 
issues. 

To activate debugging: 

1 Select Configure from the Tools menu. The TCP/IP Manager - Electronic Payments Settings 
Window appears. 

2 Select the Debug field and click OK. You are returned to the TCP/IP Manager - Electronic 
Payments Window. 

3 As transactions are processed, the processing information will display in the TCP/IP Manager - 
Electronic Payments Window. 
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3 Chapter 3 PayPal Payflow Pro  

 

 

PayPal Payflow Pro Installation and Implementation Tips 
PayPal’s Payflow Pro service is a 3rd-party product, and Infor does not support or provide 
instructions for the use of Payflow Pro.  Therefore, you should contact PayPal directly to establish 
your merchant account and for any help with their product. 

You can contact PayPal on the web at http://www.paypal.com

Credit card numbers can be entered manually or through a magnetic stripe reader, which can be 
purchased separately through PayPal. 

This section provides information on FACTS’ integration with PayPal’s Payflow Pro online credit card 
processing service.  For installation instructions, refer to chapter 2 – TCP/IP Manager for Electronic 
Payments. 

Integration with Payflow Pro 
Infor’s TCP/IP Manager for Electronic Payments is a standalone product developed by Infor that 
handles all transactions being sent from FACTS to Payflow Pro.  This product must be downloaded 
and installed on a secure Windows (XP, 2000 or 2003) computer, which is located behind your 
firewall, is visible to the FACTS server via TCP/IP, and has access to the internet to communicate 
with PayPal. 

FACTS communicates with the TCP/IP Manager, and the TCP/IP Manager in turn communicates 
with PayPal’s Payment Gateway.  
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PayPal Payflow Pro 

The installation of Infor’s TCP/IP Manager automatically installs Payflow Pro, so there is no need for 
a separate install. 

When you create a Payflow Pro account through PayPal, you should first establish a test account.  
Initially you will configure FACTS to work with the test account, and after you have confirmed that it 
is working, you will then switch to your live merchant account. 

Using Payflow Pro with FACTS 

Configuring FACTS to use Payflow Pro 
1 If you haven’t already done so, download and install the TCP/IP Manager from Infor’s Download 

Center, which will also install the files needed for Payflow Pro. 

2 Set up a cash type terms code in the Accounts Receivable Terms Code F/M. Credit cards must 
be cash type payments, not an A/R type. The General Ledger Number you choose must be a 
cash G/L account number. 

3 Complete the Company Control F/M set up for credit card processing. 

• Select P – Payflow Pro as the Credit Card Processor on the General tab 

4 Complete the Credit Card Control F/M setup:  
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PayPal Payflow Pro 

a Payflow Pro Com Agent:  

    Should be set to T – TCP/IP Manager 

b In the Communication Agent Settings section: 

• Host Address 
Host address for the TCP/IP Manager 

• Port 
Host port for the TCP/IP Manager (should be always be 8001) 

• Response Timeout 
Number of seconds until timeout connecting to TCP/IP Manager 

c In the Payflow Pro Settings section: 

• Host Address 
Payflow Pro host address or test host address. For test settings, use pilot-
payflowpro.paypal.com 
When you switch to a live account, you will need to remove the pilot- from this field. 

• Port 
Payflow Pro host port (should always be 443) 

• Response Timeout 
Number of seconds until timeout connecting to Payflow Pro 

• Vendor 
The PayPal login name (your Merchant Login when you created your PayPal account, case 
sensitive) 

• Partner 
Name of authorized PayPal reseller (usually PayPal) 

• Password 
Authorized PayPal account password (case sensitive) 

• Verbosity 
Level of detail of responses.  You can select from L-Low or M-Medium 

• Use Address Verification Service (AVS) 
Requires users who process credit cards to enter customer addresses during credit card 
transactions. This is intended to offer the customer an additional level of security by asking 
them to supply additional information 

• Automatically Decline on AVS failure 
Indicates whether you want the system to automatically void a transaction that fails customer 
address verification 

• Use Credit Card Security Code (CSC) 
Requires users to enter the security code from the back side of the customer’s credit card 
when using magnetic stripe readers during credit card transactions 

• Automatically Decline on CSC failure 
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Indicates whether you want the system to automatically void a transaction that fails credit 
card security code verification 

• Transmit To Payflow Pro 
When selected, FACTS will attempt to process transactions as they are entered. All 
transactions must be processed before you can run the Daily Sales Register (DSR).  
When unselected (not recommended), credit card transactions will require voice 
authorization and the transactions will collect in the Process Pending Transactions program 
(under the Invoices menu).  
When you are ready to transmit, select the "Transmit to Payflow Pro" checkbox, then use the 
Process Pending Transactions program to transmit the pending transactions to the credit 
card processor. For more information, refer to the Process Pending Transactions program  
topic. 

• Use Voice Authorization 
Forces the user to enter a voice authorization code for all transactions 

d In the Proxy Settings section: 

• Address 
Proxy Server address 

• Port 
Proxy Server port 

• Logon 
Proxy Server logon name 

• Password 
Proxy Server password 

• Columns for Credit Card Receipt 
This sets the width of your credit card receipts, which can range from 30 to 80 columns wide. 
Enter 0 if you do not want a receipt to print. 

• Receipt Message 
Enter the message (up to 25 characters) that you want printed at the bottom of your receipts.  

e Press the Test Settings link to test the connection to Payflow Pro using the information 
provided on this screen. Note: You must save the information BEFORE testing the settings.  

Note: This will only test the success or failure of the communication between FACTS, the 
communication agent, and PayPal. It does not validate account names,  passwords or 
transaction settings. 

5 (Optional) To print credit card receipts, set up SOP610 in Program F/M.  Then select the printer 
usage and normal printer for each terminal (the entries for fields 2-8 are arbitrary) so credit card 
receipts will print. This allows you to have one credit card receipt printer for all terminals, or a 
different printer for some terminals, as necessary. 
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Processing Credit Cards with FACTS and Payflow Pro 
After entering the terms code and the purchase amount, the credit card pop-up window appears: 

 

Note: The Address and Zip Code fields appear only if “Use Address Verification is selected in Credit 
Card Control F/M, and the Card Security Code field appears only if “Use Card Security Code (CSC)” 
is selected.  

1 Enter the credit card number or swipe the card through the reader. 

2 Enter the expiration date. If you swiped the card, the system automatically enters this data. 

3 If you selected the Use Address Verification checkbox in the Credit Card Control F/M, enter the 
customer’s street address and Zip code.  

4 If you selected the Use CSC checkbox in the Credit Card Control F/M, enter the customer’s 
credit card security code.  

5 Click Process to process the transaction. 
 
A mini dialog box will appear, telling you the system is waiting for a response.  
 
If the credit card processing company does not answer or respond within the time set in the 
Credit Card Control F/M, the system gives you either a recognition timeout (if the provider does 
not respond at all) or a response timeout (if the provider’s system answers but does not approve 
or decline within the response time). 
 
Recognition timeouts. You may wait again or cancel the transaction. Canceling a document 
after a recognition timeout creates no problems because the processing company is not aware of 
the transaction.    
 
Response timeouts. You have the option to wait or hold the document. If you choose to hold, 
you must call the processing company to determine whether the transaction has been approved 
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or declined. 
 
If for some reason the swipe device isn’t working, the card processing company is offline or the 
Voice Authorization flag in the Credit Card Control F/M is set to Y, the person entering the credit 
card transaction will need to call the processing company and enter the provided authorization 
code in the prompt that appears. 
 
At the end of the transaction, FACTS checks to see if you are signed on to a cash drawer. If not 
it asks you to do so. Press F2 to search. 

Using the Process Pending Transactions program  
(Communications down) 

In cases where your processing company is offline or Payflow Pro is down, you can still force sales 
and reconcile the transactions later.  

At the end of the shift or day, enter the Process Pending Transactions program from the Invoices 
menu. If transactions are pending, enter YES to begin processing. This program must be run before 
the daily Sales Register is updated. 

If everything runs smoothly, the system tells you the “Batch Processing of Pending Transactions Is 
Complete,” and you can press Enter (CR) to return to the Invoices menu. 

If a transaction is declined, it must be resolved (e.g. with another method of payment), and the 
Process Pending Transactions program must be run again. 

As with single credit card transactions, recognition and response timeouts sometimes occur. If you 
get a recognition timeout, you can wait or press F3 to stop processing. 

If you are faced with a response timeout, you can either wait or abort the process. Be advised that 
when you abort the process, you will need to call your processing company and verify which 
transactions they received. Those they did not receive will have to be settled through the Payflow 
Pro software.  

• Refer to the Sales Orders manual for more information on Credit Card Handling F/M and 
Process Pending Transactions. 

You can use the following dummy credit card numbers when in test mode to test communications:  

MasterCard: 5555555555554444 

Visa: 4111111111111111 

American Express: 371449635398431 

Different transaction amounts will return different return codes from Payflow Pro while in test mode.  
Refer to the Payflow Pro documentation for more details.  
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Credit Card Processing with Voice Authorization 
When voice authorization is required, either because the Credit Card Processor in Company Control 
F/M is set to M -  Manual, the “Voice Authorization” box is checked in Credit Card F/M, or a failure 
occurred when communicating to the credit card processor, FACTS opens a pop-up window, which 
confirms that you are in voice-authorization mode and the amount of the purchase and whether the 
transaction is a sale, void sale, credit or void credit.  

In this window, enter the customer’s credit card number and the expiration date.   

The system then asks whether it is OK to process a sale.  

Select OK to continue with the sale, and call your credit card processing company to authorize the 
sale.  Enter the authorization code in the prompt provided. 
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Switching from a Test Account to a Live Merchant Account 
When you are finished testing Sales Orders in your test environment and you are ready to begin 
using electronic payments in a live environment, you complete the steps in this section to switch to a 
live merchant account. 

1 Apply for a merchant account with PayPal. 

PayPal provides an automated online application that you will use to apply for a merchant account. 

a Log in to your PayPal account at https://manager.paypal.com. 

b Follow the instructions for applying for a merchant account. You will need 5-10 minutes to 
complete the application. Account approvals typically take 24 hours. 

2 Set up your Credit Card Options for the merchant account. 

At minimum, in Credit Card Control F/M, you will need to change the host address to the merchant 
account address (payflow.PayPal.com). You may also need to change your user ID and password. 

3 Verify your PayPal Security Transaction Settings. 

a Log in to your account at https://manager.paypal.com. When logging in, your partner ID is 
PayPal (or VeriSign on older accounts). Use the user ID and password you specified when 
you created the account. 

b In the PayPal Manager, select the Account Administration link at the top of the page. Then 
select the Manage Security settings link.   

c In the Transactions Settings section, make sure the Allow Non-referenced Credits setting is Yes. 

d Verify that the remaining settings in the Edit Your Transactions section are correct. 

Card Reader Requirements 
Your card reader must be configurable to match the following requirements:  

• Returning both card tracks  
• Prefacing the read (or the first track) with a header of "%"  
• Terminating each track w/either a carriage return ($0D$) or a line feed ($0A$)  
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4 Chapter 4 Using ICVerify 

 

 

Using ICVerify with FACTS 
This section provides information on FACTS’ integration with the ICVERIFY credit card processing 
service.  ICVERIFY is a 3rd-party product, and Infor does not support or provide instructions for the 
use of ICVERIFY.  Therefore, you should contact ICVERIFY directly to establish your merchant 
account and for any help with their product. 

You can contact ICVERIFY on the web at http://www.icverify.com 

Credit card numbers can be entered manually or through a magnetic stripe reader, which can be 
purchased separately through ICVERIFY. 

Configuring FACTS to use ICVERIFY 
1 Go to the System Management System Control F/M. Enter the number of ICVERIFY licenses 

your company purchased at the ICVERIFY Licenses field. FACTS supports up to 999 licenses. 

2 Set up a cash type terms code in the Accounts Receivable Terms Code F/M. Credit cards must 
be cash type payments, not an A/R type. The General Ledger Number you choose must be a 
cash G/L account number. 

3 In System Control F/M, choose I – ICVerify 3.1 as your Credit Card Processor.  FACTS’ 
integration to ICVERIFY supports very limited versions of the ICVERIFY product, be very careful 
to determine what version is supported with your FACTS release. 
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4 Go to the Credit Card Control F/M in System Management File Maintenances. 

 
• Enter the Transaction Polling Directory. This is the path to the server acting as your ICVERIFY 

“master” station (see the ICVERIFY user manual for more information on its setup). The path 
must be 60 characters or less. 

• Set the recognition time out value up to 999 seconds.  
• Set the response time out value.  
• Select the Use Voice Authorization Only checkbox. 
• Select the User Address Verification checkbox based on your company needs. If you select 

this checkbox, the system requires that you enter the customer’s address and Zip code on all 
transactions. 

• Select the Use Last 4 Digit Security checkbox. Credit card transactions work with this flag set 
to N; however, for your customers’ benefit, it is recommended that you activate this flag. 

• Select the Transmit to ICVERIFY flag checkbox. 
• Enter the number of columns over which you want the credit card receipts to print. The 

available range is between 30 and 80 columns (30 produces a 2½-inch wide receipt).  
• Enter the message you would like printed on the receipts. This entry is optional. 

5 (Optional) To print credit card receipts, set up SOP610 in Program F/M.  Then select the printer 
usage and normal printer for each terminal (the entries for fields 2-8 are arbitrary) so credit card 
receipts will print. This allows you to have one credit card receipt printer for all terminals, or a 
different printer for some terminals, as necessary. 
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Processing Credit Cards with FACTS and ICVERIFY 
After entering the terms code and the purchase amount, the credit card pop-up window appears if 
the “Use Address Verification” option checked in Credit Card Control F/M.   
 

 

Note: The Address and Zip Code fields only appear if you have “Use Address Verification” 
selected in Credit Card Control F/M.  

1 Enter the credit card number or swipe the card through the reader. 

2 Enter the expiration date. If you swiped the card, the system automatically enters this data. 

3 If you select the Use Address Verification checkbox in the Credit Card Control F/M, enter the 
customer’s street address and Zip code.  
 
Note:  If you swiped the card and “Use Last 4 Digit Security” is checked in Credit Card Control 
F/M, FACTS displays the screen below so you can enter the last four digits of the credit card. 
Press OK or Cancel Force to not require the last four digits.   

 
4 When you return to the Credit Card Information screen, click Process to process the transaction. 

5 A mini dialog box will appear, telling you the system is waiting for recognition and then a 
response.  
 
If the credit card processing company does not answer or respond within the time set in the 
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Credit Card Control F/M, the system gives you either a recognition timeout (if the provider does 
not respond at all) or a response timeout (if the provider’s system answers but does not approve 
or decline within the response time). 
 
Recognition timeouts. You may wait again or cancel the transaction. Canceling a document 
after a recognition timeout creates no problems because the processing company is not aware of 
the transaction.    
 
Response timeouts. You have the option to wait or hold the document. If you choose to hold, 
you must call the processing company to determine whether the transaction has been approved 
or declined. 

6 If for some reason the swipe device isn’t working, the card processing company is offline or the 
Voice Authorization flag in the Credit Card Control F/M is set to Y, the person entering the credit 
card transaction will need to call the processing company and enter the provided authorization 
code in the prompt that appears. 
 
At the end of the transaction, FACTS checks to see if you are signed on to a cash drawer. If not 
it asks you to do so. Press F2 to search. 
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Using the Process Pending Transactions program  
(Communications down) 

In cases where your processing company is offline or ICVERIFY is down, you can still force sales 
and reconcile the transactions later.  

At the end of the shift or day, enter the Process Pending Transactions program from the Invoices 
menu. If transactions are pending, enter YES to begin processing. This program must be run before 
the daily Sales Register is updated. 

If everything runs smoothly, the system tells you the “Batch Processing of Pending Transactions Is 
Complete,” and you can press Enter (CR) to return to the Invoices menu. 

If a transaction is declined, it must be resolved (e.g. with another method of payment), and the 
Process Pending Transactions program must be run again. 

As with single credit card transactions, recognition and response timeouts sometimes occur. If you 
get a recognition timeout, you can wait or press F3 to stop processing. 

If you are faced with a response timeout, you can either wait or abort the process. Be advised that 
when you abort the process, you will need to call your processing company and verify which 
transactions they received. Those they did not receive will have to be settled through the ICVERIFY 
software.  

Refer to the Sales Orders manual for more information on Credit Card Handling F/M and Process 
Pending Transactions. 
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Credit Card Processing with Voice Authorization 
When voice authorization is required, either because the Credit Card Processor in Company Control 
F/M is set to M - Manual, the “Voice Authorization” box is checked in Credit Card F/M, or a failure 
occurred when communicating to the credit card processor, FACTS opens a pop-up window, which 
confirms that you are in voice-authorization mode and the amount of the purchase and whether the 
transaction is a sale, void sale, credit or void credit.  

In this window, enter the customer’s credit card number and the expiration date.   

The system then asks whether it is OK to process a sale.  

Select OK to continue with the sale, and call your credit card processing company to authorize the 
sale. Enter the authorization code in the prompt provided. 

Enter the authorization code in the prompt provided and select OK to process. Select Cancel Force 
to not require security code entry for the transaction. 

 

Card Reader Requirements 
Your card reader must be configurable to match the following requirements:  

• Returning both card tracks  
• Prefacing the read (or the first track) with a header of "%"  
• Terminating each track w/either a carriage return ($0D$) or a line feed ($0A$)  
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